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2Molecular Tension Microscopy of E-Cadherin During
3Epithelial-Mesenchymal Transition
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5Philippe P. Girard, and Nicolas Borghi

6Abstract

7Molecular Tension Microscopy has been increasingly used in the last years to investigate mechanical forces
8acting in cells at the molecular scale. Here, we describe a protocol to image the tension of the junctional
9protein E-cadherin in cultured epithelial cells undergoing Epithelial-Mesenchymal Transition (EMT). We
10report how to prepare cells and induce EMT, and how to acquire, analyze, and quantitatively interpret
11FRET data.

12Key words FRET Biosensor, E-cadherin, EMT, Microscopy, Mechanotransduction

131 Introduction

14Molecular TensionMicroscopy (MTM) is the microscopy of molec-
15ular tension sensors [1]. Molecular tension sensors are a class of
16Förster Resonance Energy Transfer (FRET) sensors that are sensi-
17tive to molecular tension. They consist in a FRET pair of fluoro-
18phores separated by an elastic linker. When a force is exerted on the
19sensor, the rate of FRET, which is sensitive to the distance and
20orientation between the donor and acceptor fluorophores,
21decreases. Knowledge of the relationship between a measure of
22FRET and the force, from in vitro calibration, allows for the deter-
23mination of molecular tension [2]. When inserted in a protein of
24interest, such a sensor can report its tension in live cells.
25Molecular tension sensors have been in use for nearly 10 years
26[3]. A variety of sensors with specific operating ranges have been
27designed [4, 5], and have been used to measure tension in matrix,
28cytoskeleton, adhesion, glycocalyx, kinetochore, membrane-
29cytoskeleton linker or motor proteins [2, 3, 6–9] in cultured cells,
30C. elegans, Xenopus, Zebrafish, or Drosophila [3, 10–12].
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31Here, we present a protocol to perform MTM of intercellular
32adhesion proteins E-cadherins [13] that experience cytoskeleton-
33generated tension sensitive to external cues [14]. During
34Epithelial-Mesenchymal Transition (EMT), E-cadherin tension
35relaxes, which associates with the release of its interactant
36β-catenin and activation of β-catenin dependent transcription [15].
37The protocol describes how to culture epithelial cells (MDCK)
38stably expressing an E-cadherin tension sensor (E-cadherin-
39TSMod), induce EMT, and acquire and analyze FRET data using
40standard confocal microscopy and free image analysis software [16]
41(see Fig. 1). The protocol may be adapted to other proteins or
42model systems, on different microscopes as well. General consid-
43erations about MTM, its strengths and limitations can be found
44elsewhere [1].

452 Materials

46Store DMEM (Dulbecco’s Modified Eagle Medium), trypsin, Dul-
47becco’s Phosphate Buffered Saline (DPBS, that is without Calcium
48and Magnesium), collagen at 4 �C. Store Foetal Bovine Serum
49(FBS), Penicillin, Streptomycin, and Hepatocyte Growth Factor
50(HGF) solution at �80 �C.

2.1 Cell Culture 511. Culture medium: low glucose DMEM with phenol red supple-
52mented with 10% v/v Foetal Bovine Serum (FBS) and Penicil-
53lin 10 U/mL + Streptomycin 10 μg/mL.
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Fig. 1 Experimental workflow for MDCK type II cells sample preparation, EMT
induction, image acquisition and image and data analysis
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542. Washing medium: DPBS.

553. 0.05% trypsin-EDTA solution in DPBS.

564. Madin-Darby canine kidney type II (MDCK II) stable cell lines
57cultured into 25 cm2 flasks (T25, TPP) at 37 �C with 5% CO2

58in humidified atmosphere expressing (see Fig. 2a):

595. E-cadherin-TSMod: E-Cadherin tension sensor containing the
60donor protein mTFP1 and acceptor protein EYFP separated by
61a (GPGGA)8 elastic linker [14].

626. E-Cadherin-TSModΔcyto: tension-less control construct of
63the E-Cadherin tension sensor, lacking its cytoplasmic tail
64[14] (see Note 1).

657. mTFP1-GPGGA-Venus: high FRET standard construct made
66of mTFP1 and Venus separated by a GPGGA amino acid
67stretch (referred to as 5aa) [17].

E-Cadherin-TSMod

E-Cadherin-TSModΔcyto

mTFP1-5aa-Venus

mTFP1-TRAF-Venus

a

b c

Donor

Acceptor

5aa

TRAF
(GPGGA)8 mTFP1 EYFP/Venus

Fig. 2 (a) E-Cadherin-TSMod, tension-less control E-Cadherin-TSModΔcyto, and high and low FRET calibra-
tion constructs. Blue squares represent the donor fluorophore mTFP1, yellow squares represent the acceptor
fluorophore EYFP/Venus. Linkers (GPGGA)8, 5aa, and TRAF are represented in black. (b) Absorption and
emission spectra of mTFP1 and EYFP/Venus. Laser excitation wavelength is indicated by the red dashed line.
(c) Spectral emission in the detection bandwidth for mTFP1 and EYFP. Donor and acceptor emission peaks are
indicated
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688. mTFP1-TRAF-Venus: low FRET standard construct made of
69mTFP1 and Venus separated by a 229 amino acid from Tumor
70Necrosis Factor Receptor Associated Factor domain (referred
71to as TRAF) [17].

72All cell lines and constructs are available on demand.
73

2.2 Cell Imaging 741. Any commercial #1.5 glass-bottomed imaging dish.

752. Collagen from human placenta Bornstein and Traub Type IV
76(referred to as collagen) 50 μg/mL in acetic acid solution:
77solubilize 5 mg of collagen in 5 mL of acetic acid (0.5 M) on
78ice to obtain a 20� stock solution. Dilute in acetic acid (0.5 M)
79to obtain a solution at the final concentration of 50 μg/mL.

803. Imaging medium: FluoroBrite™ DMEM (or any equivalent
81product), without phenol red, supplemented with 10% v/v
82FBS, 1% v/v PS, 2.5 mM L-Glutamine and 20 mM HEPES.
83Store away from light.

844. Starvation medium: FluoroBrite™ DMEM, without phenol
85red, supplemented with 0.5% v/v FBS, 1% v/v PS, 2.5 mM L-
86Glutamine and 20 mM HEPES. Store away from light.

875. Paraffin oil. Store away from the light at room temperature.
88

2.3 Cell

Scatter Assay

891. Hepatocyte Growth Factor (HGF) 10 ng/μL in BSA/DPBS
90solution: solubilize 1 mg of BSA (Bovine Serum Albumin) in
911 mL of DPBS. Solubilize 10 μg of HGF in the BSA/DPBS
92solution. Stock as 10 μL aliquots.

932. Stimulation medium: The day of the experiment, dilute an
94aliquot in 2 mL of starvation medium for a final HGF concen-
95tration of 50 ng/mL.
96

2.4 Wound

Healing Assay

971. 200 μL pipette tips.

982. Washing medium.
99

2.5 Microscope 1001. Commercial confocal inverted microscope equipped with an
101incubator (37 �C and 5% CO2 in a humidified atmosphere).

1022. High numerical aperture immersion objectives (see Note 2).

1033. Argon laser—the 458 nm line is optimal for mTFP1 excita-
104tion—or equivalent, and a beam splitter that transmits above
105the excitation wavelength.

1064. Spectral acquisition: microscopes that use a grating in the
107emission path (such as Zeiss or Olympus) allow for simulta-
108neous acquisition of the donor and acceptor emission spectra
109with a spectral resolution below 10 nm and nm precision (see
110Fig. 2b, c).
111
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1123 Methods

113Carry out all procedures in a cell culture hood unless otherwise
114specified.

3.1 Cell Culture

Maintenance

115Pass MDCK II cells three times a week as follows:

1161. Prepare a new cell culture flask containing 3 mL of fresh culture
117medium and put it into the incubator.

1182. Remove old culture medium and dead cells from the cell cul-
119ture flask.

1203. Wash once with 1 mL of washing medium and by gently
121shaking the cell culture flask.

1224. Add 1 mL of Trypsin-EDTA solution in DPBS to the cell
123culture flask.

1245. Put the cell culture flask into incubator and wait about 10 min
125for cells to detach from the surface and from each other.

1266. Use a microscope to evaluate cell detachment.

1277. Once cells are detached, transfer 1:10 of the collected volume
128into the new flask.
129

3.2 Collagen

Preparation and

Coverslip Coating

1301. Take glass-bottomed imaging dishes.

1312. Place 1 mL of collagen solution at 50 μg/mL onto the glass-
132bottomed dish for 10 min at room temperature.

1333. Remove collagen solution and let dry for 1 h (see Note 3).

1344. Sterilize the dishes under UV for 20 min (see Note 4).

1355. Before use, wash the sterilized dishes with at least 1 mL of
136DPBS, twice.
137

3.3 Cell Seeding for

Imaging

138Seed cells 24 h before imaging. Prepare cells that express the
139tension sensor as well as cells that express the tension-less control
140separately. Follow steps 1–6 of the Subheading 3.1 and continue as
141follows:

1421. Collect the cell suspension into a sterile centrifugation tube.

1432. Pellet the cells by centrifugation at 60–125 � g for 5–8 min.

1443. Meanwhile, add culture medium onto the collagen coated
145imaging dishes.

1464. Discard the supernatant of the centrifugation tube and
147re-suspend the pellet with culture medium (see Note 5).

1485. Count cells with a hematocytometer or equivalent device.

1496. Plate 1:10 of the collected volume in a new flask with culture
150medium.

Molecular Tension Microscopy of E-Cadherin During EMT



1517. Plate cells onto collagen coated imaging dishes: 2 � 105 for a
152cell scatter assay or 2 � 106 for a Wound Healing assay (see
153Note 6).
154

3.4 Cell

Scatter Assay

1551. The day after seeding, starve cells for 12 h in 2 mL imaging
156medium at 0.5% FBS.

1572. Wipe the bottom of the glass-bottomed dish once with optical
158paper and distilled water, and again with ethanol 70%.

1593. Install the imaging dish on the stage of the microscope.

1604. Acquire pre-treatment images (see Subheading 3.6).

1615. Replace the imaging medium with stimulation medium (see
162Note 7).

1636. Add 1 mL paraffin oil at the surface of the imaging medium to
164prevent evaporation (see Note 8).

1657. Acquire treatment images (see Subheading 3.6).

166It is recommended to perform a mock experiment in parallel by
167following steps 1–7 except step 5 in which the medium does not
168contain HGF.
169

3.5 Wound

Healing Assay

1701. The day after seeding, wash and leave cells in the washing
171medium for 5–10 min to loosen intercellular contacts (see
172Note 9).

1732. With a 200 μL pipette tip, perform a straight scratch in the cell
174monolayer (see Note 10).

1753. Gently wash the dish with imaging medium and leave cells in
1762 mL of imaging medium.

1774. Any time after the wound, wipe the bottom of the coverslip as
178in Subheading 3.4, step 2 and install the imaging dish on the
179stage of the microscope, add paraffin oil and acquire images (see
180Subheading 3.6).
181

3.6 Image

Acquisition

1821. Select an objective and exposure time to ensure sufficient signal
183to noise ratio, negligible fluorophore photobleaching and no
184saturation, as for standard fluorescence imaging.

1852. Specify multi-position settings: if desired, acquiring images
186frommultiple positions can increase your sample size per exper-
187iment. Choose between 5–10 positions considering that the
188total acquisition time of each position must not exceed the
189duration of the time interval between frames (see Note 11).

1903. Specify Z-stack settings: if desired, this can alleviate focus drift if
191auto-focus is out-of-order. Make sure to avoid photobleaching.

1924. Specify time-lapse settings: cell scattering by HGF and wound
193healing typically occur through several hours. Choose a time
194interval between frames of 10 min to 1 h (see Note 12).
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1955. Specify spectral acquisition settings: 10 channels in the
196473–561 nm bandwidth will capture both fluorophores. This
197will generate a multichannel stack.
198

3.7 Image Analysis 199Image analysis can be performed using the free and cross-platform
200software ImageJ, for instance its FIJI distribution (https://fiji.sc/)
201(see Fig. 3).

2021. Make duplicates of the raw data to avoid losses after permanent
203modifications (see Note 13). Generate a FRET index image as
204follows.

2052. Open an image file.

2063. From the multichannel stack, duplicate the donor and acceptor
207emission channels (D and A) that correspond to the intensity
208peaks of the two fluorophores (see Note 14).

2094. On both channels, convert image depth to 32-bit
210(Image>Type>32-bit).

2115. On both channels, subtract background: select a region devoid
212of cells and measure background level (Analyze>Measure),
213then subtract the value to the whole image (Pro-
214cess>Math>Subtract [Background value]) (see Note 15).

Manual 
selection

Region(s) Of Interest

Measure

Spectral image

Segmentation

FRET Index 
image

Thresholding

Particle analysis

Acceptor channel

Donor channel

+

32-bit conversion

Background 
substraction

Filtering (optional)

FRET calculation

X 100

+

Donor/Acceptor 
selection

Fig. 3 Image analysis workflow for FRET calculation and image segmentation from a multi-channel spectral
image
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2156. From both channels, generate a donor + acceptor image
216(D + A) that sums background corrected, donor and acceptor
217signals pixel by pixel. (Process>Image Calculator>Create new
218window>32-bit(float) result >[D] Add [A], Create a new
219window).

2207. From the background corrected, acceptor channel and the sum
221image, generate the FRET index image A/(D + A) (Process>-
222Image Calculator>Create new window>32-bit(float) result>
223[A] Divide [D + A]).

2248. Rescale the pixel values between 0 and 100. (Pro-
225cess>Math>Multiply [100]).

2269. Select regions of interest (ROI) with any selection tool, then
227measure their mean gray value (Analyze>Measure) to get their
228FRET index.

22910. Alternatively, ROI can be defined by segmentation based on
230fluorescence intensity, size and shape: select the acceptor chan-
231nel (see Note 16), apply a threshold to select bright regions
232(Image>Adjust>Threshold, set to your taste then Apply) (see
233Note 17). Choose preferred bright regions according to size
234and shape by setting their ranges (Analyze>Analyze Particles,
235check Add to Manager) (see Note 18). In the ROI manager
236menu, save the ROI set to be able to recall it for future analyses
237(More>Save). Select/Open the corresponding FRET Index
238image (see Subheading 3.7, step 7) and click Measure in the
239ROImanager menu. You will obtain a measure for each ROI of
240the set.
241

3.8 Microscope

Calibration

242The FRET efficiency E can be related to the FRET index ER

243computed as in 3.7 with E ¼ (1 � a(1 � ER))/(1 � b(1 � ER)),
244where a and b are instrument-dependent coefficients that account
245for the donor’s spectral bleed-through, the acceptor’s direct excita-
246tion and differences in donor vs acceptor absorption cross-sections
247and detection efficiencies [18]. They can be recovered as follows
248(see Note 19):

2491. Acquire images of the 5aa and TRAF cell lines as in Subheading
2503.6. There is no need for time-lapse or Z-stack.

2512. Analyze images as in Subheading 3.7.

2523. Compute a ¼ (EH(1 � ER,H) � EL(1 � ER,L) + EHEL(ER,

253H � ER,L))/c and b ¼ (EH(1 � ER,L) � EL(1 � ER,H) + ER,

254L � ER,H)/c, with c ¼ (EH � EL)(1 � ER,H)(1 � ER,L), where
255ER,H and ER,L are the 5aa and TRAF cell lines FRET indices
256obtained in Subheading 3.8, step 2, and EH and EL their FRET
257efficiencies published elsewhere [17].
258
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3.9 Data

Interpretation

2591. For each experimental condition, compute the difference
260between the tension sensor and tension-less control FRET
261efficiencies (see Note 20).

2622. Use previously published FRET efficiency to force calibration
263[2] to retrieve the force.

2643. Mind MTM limitations in your interpretation [1].
265

2664 Notes

2671. There exist other strategies for tension-less constructs, which
268may or may not give equivalent results depending on the
269protein of interest, as discussed in [1].

2702. High magnification is irrelevant but comes with high numerical
271aperture, which increases resolution and signal intensity, and
272should also come with apochromatic correction. Choose the
273highest you can, typically 1.4 for standard objectives.

2743. Save used collagen solution back in the final concentration
275solution for later use. Store at 4 �C indefinitely.

2764. Use the UV light of the cell culture hood. Do not cover the
277dishes with a plastic lid. Multiple dishes can be prepared in
278advance and stored on the shelf indefinitely.

2795. When re-suspending cells, pipette up and down to shear and
280dissociate cell aggregates. This will facilitate homogenous
281seeding.

2826. When seeding, make sure the cell suspension covers the whole
283coverslip by gently shaking the dish linearly in X and Y, not
284circularly as cells would aggregate at the center of the coverslip.

2857. Execute with care and promptly directly on the microscope
286stage to keep focus, temperature and position the same.

2878. Make sure there is enough oil to cover the whole surface of the
288imaging medium to prevent evaporation.

2899. Check that the monolayer is confluent before this step.

29010. Two perpendicular scratches maximize wound edge length per
291coverslip. Use/draw fiducial markers on the coverslip/imaging
292chamber to easily find the wound once on the microscope
293stage.

29411. Selecting positions in close proximity minimizes the spreading
295and loss of the objective immersion medium.

29612. Consider the total acquisition time per time-point (multiple
297positions and Z sections), the total duration of the time-lapse,
298photobleaching and phototoxicity. 20- to 30-min intervals are
299adequate for most experiments.
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30013. Name your processed files consistently with the original files
301but with a different name to prevent overwriting.

30214. Always keep the same donor and acceptor channels throughout
303all your analyses. You can identify them by plotting the inten-
304sity of a region containing fluorophores against the wavelength
305(or channel number) (select the multichannel stack then Ima-
306ge>Hyperstacks>Hyperstack to Stack, then select a region and
307Image>Stacks>Plot Z-axis profile). The plot should display
308two maxima (around 490 and 530 nm), if not, do not analyze
309further: the cell has likely not processed the full construct
310properly.

31115. Before this step, you may filter some noise by local averaging of
312pixel levels, at the expense of spatial resolution (for instance,
313Process>Filters>Gaussian Blur).

31416. For E-cadherin-TSMod, the donor channel often exhibits
315intracellular aggregates, probably synthesis or degradation
316intermediates in which the acceptor fluorophore does not
317emit. Hence, the acceptor channel is preferred.

31817. You can explore the different tools available on Image J to
319process binary images (Process>Binary>. . .) to improve seg-
320mentation from the thresholded image.

32118. More information on how to use the ROIManager tool can be
322found here (https://imagej.nih.gov/ij/docs/guide/). Size
323and shape selection can be very useful to exclude regions too
324small or round to be cell–cell contacts. In the ROI Manager,
325you can delete unwanted regions (>Delete) or add missing
326regions (draw with any selection tool then >Add).

32719. This does not need to be done for every experiment but can be
328performed from time to time to assess the microscope stability.

32920. The Ecad-TSModΔcyto is sensitive to intermolecular FRET
330[14]. This normalization thus corrects for possible FRET
331changes due to intermolecular FRET among other causes.
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